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MARC Definition 

“MARC stands for Machine Readable Cataloging.   MARC is simply a standard for 
recording bibliographic information that was once widely found on catalog cards and putting that 
information into machine-readable form. MARC is a world standard for the recording of 
bibliographic information.” 1 

MarcEdit 

MarcEdit is  free MARC editing utility which can also be used to convert data from LIMS, 
delimited tab text, WINSISI ISO to MARC format, developed by Terry Reese, 

 System Requirements: 

 Operating System: Windows 95, 98, ME, NT 4+, 2000, XP. 
 RAM: 8 MB (min); 32 MB+ (recommended) 
 Disk space: 10 MB (setup); 5 MB (application) 
 Special Requirement: 

Because MarcEdit installs a number of Active X Objects, the user must have 
administrator permissions to install on Windows NT (NT 4+, 2000, XP) 

File Extensions Used by MarcEdit: 

MarcEdit associates *.mrc files with the MarcBreaker, *.mrk files with the MarcEditor, and 
*.mrd files with the save mapping as Save Arguments Template.  

Marcedit is available free from: 
(http://oregonstate.edu/~reeset/marcedit/html/downloads.html) 

For bugs removal and more information about MarcEdit contact Terry Reese 

Terry Reese 
Cataloger for Networked Resources 
Digital Production Unit Head 
Oregon State University Libraries 
Corvallis, OR  97331 
tel: 541-737-6384 
email: terry.reese@oregonstate.edu 
http: http://oregonstate.edu/~reeset

 

 

 

 

 

 

http://oregonstate.edu/~reeset/marcedit/html/downloads.html
http://oregonstate.edu/~reeset
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Conversion of Library Data into MARC Format 

If you are not using any type of Library system and it is your desire that your data should also be 
available at: www.loc.gov/z3950 (Loc Gateway). 

Procedure: 

If your’ Books data is not in computerized form then first of all go the site of loc: 
http://catalog.loc.gov. Select the Basic search. 

 

Search your Library book in the catalog of Loc through title search when you find the same title. 
Then save this record in Marc format and check the option of Marc Format (Only Save). As 
shown in this picture. 

 

Clicking on this option will result in the marc record entry of the book as show below. 

http://www.loc.gov/z3950
http://catalog.loc.gov/
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Select (ctrl+a) the record and copy it, open Notepad, paste (ctrl+v) MARC record in notepad and 
select word wrap from notepad-format menu. You can save multiple MARC records in notepad for 
further editing with MarcEditor or converting them into LIMS compatible format.  

Open MarcBreaker using MarcEdit software home page. This can be done either by using file 
menu MARC Tools =>open MarcBreaker or selecting from main screen of MarcEdit. See image 
below. 

 

Following window will appear as result of choosing this option asking about Input File and Output 
File. Provide your saved marc file (from LOC) path in input and write name of file to be saved in 
Output File with .mrk extension. Press Execute button.   
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Open mrk extension file in MarcEditor and make the essential changes in this file and remove the 
unnecessary sign and symbols from this file and save it. Convert this saved file into the marc 
Communication format as follows: 

 

Test your records after running the zebra server and the procedure will be same as it is 
mentioned in zebra help file. 
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Conversion of MARC Record into LIMS (MS Access) Compatible Format 
with MarcEdit 

Following MARC tags are required for conversion: 

TAG Subfield 

001 
020 a 
082 a 
100 a 
245 a 
245 b 
245 c 
250 a 
260 a 
260 b 
260 c 
300 a 
440 a 
504 a 
505 a 
650 
700 

MarcEdit Main Menu =>Tools=>Export Tab Delimited Records following windows will appear 

 

Select MARC file saved from LOC Catalog in first box and name of output file in second box. Add 
above mentioned tags one by one and press ok, there will be message records “Records have 
exported successfully” and closes it. 

Open marc database in marcrenew folder go to File=>Get External Data=>Import and select 
locmarc1tab.txt. This is Ms Access Database provided on CD. 
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Click Next. 

 

Select tab and First Row Contains Filed Names, and click Next. 
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If you are importing first time select in a New Table otherwise select in an Existing Table and 
select table it is unto you, you can import in New Table every time. 
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Chose your own primary key, which is 001 and Press Next. 

 

Press Finish. 
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LIMS to MARC Conversion: 

Note: Change the currency sign and year in this way first of all go to the setting then control panel 
Regional options       go to the option Currency then change the Dollar sign with Rs. And 
make the changes in year in the same way. 

Procedure: 

It is advisable to make new database, import sahlib and create table with Make-Table Query. 

1. Design ‘Make-Table Query’ and export table. 

2. Conversion of LIMS to MARC through MarcEdit Software. 

1. Criteria of Designing “Make Table Query” and Export the table: 

I. First of all design the query in your database           Select object Query              Design View      
Add your main table              select the fields according to this sequence. 
 

SELECT sahlib.ENTRYDATE, sahlib.ACCNO, [sahlib.ISBN]+" : " AS ISBN, sahlib.PRICE, 
sahlib.BINDING, sahlib.SOURCE, sahlib.DDC_NO, sahlib.AUTH_MARK, sahlib.AUTHOR, 
sahlib.TITLE, sahlib.SubTitle, sahlib.STATEOFRESP, sahlib.TYPE, sahlib.EDITION, 
[sahlib.place]+" : " AS Place, [sahlib.publisher]+", " AS Publisher, [sahlib.year]+"." AS 
[YEAR], sahlib.VOLUME, [sahlib.rmnpage]+", "+[sahlib.pages]+"p." AS page, 
sahlib.CD_FLOPY, sahlib.SERIES, sahlib.NOTES, sahlib.CONTENTS, sahlib.LANGUAGE, 
sahlib.Subject, sahlib.SubAuthor INTO 6k 
FROM sahlib 
WHERE (((sahlib.ACCNO) Between 6000 And 3001) AND ((sahlib.STATUS) Is Null)); 

After this right click on empty window select the option of Query Type then click on make table 
query. Then give the name of table.   

Save this table               select it                 right clicks on table              Export                Save in 
any drive as txt files. Export text wizard open. 

Export Text Wizard: 
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Check the option of Delimited –characters such as comma or tab separate each field (which has 
been shown in the Export text wizard through the sign of arrow).Click on Next then check the 
option Tab. 

 

Select the option next in this Window then Finish. 

2. Conversion of LIMS to MARC Using MarcEdit Software. 
 

Limsmarc.mrd files contents are given bellow 

0--005--0 

1--001--0 
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2-\\-020$a--0 

3-\\-020$c--0 

4-\\-020$c--0 

5-\\-037$b--0 

6-\\-082$a--0 

7-\\-082$b--0 

8-\\-100$a--0 

9-\\-245##$a--0 

10-\\-245##$b--0 

11-\\-245##$c--0 

12-\\-245$h--0 

13-\\-250$a--0 

14-\\-260$a--0 

15-\\-260$b--0 

16-\\-260$c--0 

17-\\-300$a--0 

18-\\-300$a--0 

19-\\-300$e--0 

20-\\-440$a--0 

21-\\-500$a--0 

22-\\-504$a—0 

23-\\-505$a--0 

24-\\-546$a--0 

25-\\-653#0$a--0 

26-\\-700$b—0 
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27-\\-850$--0 

28-\\-852$--0 

Copy the fields and their tags (as mentioned above) in notepad save the file in this way write the 
any name of file like “limsmarc.mrd”and save it in MarcEdit folder or copy limsmarc file from 
marcrenew folder into your MarcEdit folder. In above .mrd file 245$c stands for subtitle while 
500$, 505$, 850$, 852$ stand for general notes, contents, holding Institute and Location (shelf) 

Add- INS. Another window will open then click on next then give the saved file path. Next 
window will open as shown above. Instead of fields selection, giving tags in map to option 
and apply them, only click on Load template, select the path where you have putted  
notepad file  then open it then   All the tags will enter automatically 

Open MarcEdit software. 

 

Click on Add-ins              Delimited Text Translator              Click on Next in new Window, see 
below 
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When you click on next, a new window will appear asking you to provide path of file you want to 
import i.e. marcnew\3k.txt file, which you have exported from LIMS and name of marc file to be 
saved e.g. marcnew\3k.mrk . See image below. 

 

Select Tab as Delimiter and click on next. Click on Load template in new appeared window 
(Limsmarc.mrd) 
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Click Load Template, but first check the Order of your table fields which  should be according to 
marc tags give in limsmarc.mrd file (If you use  lims datababse’s maketablequery given in 
marcrenew folder, no need to worry about order of your fields.) 

 

Open lismmarc.mrd 
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Click Finish Button and follow instructions given below at 3 of 3 and then close. 

 

Open your mrk extension file double clicking it or go to the Home page of MarcEdit then click on 
MarcEditor 
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Use file menu to open your saved mrk file in MarcEditor  

 

This opened file contain quotation marks (“), which you can remove using replace option in Edit 
Manu. Write “ mark in find what box and keep second text box Replace with, blank and click 
Replace All button. Press save button on MarcEdit Tool Bar. Here we can add, delete or edit 
fields or subfields (all options are available in tools). 
File=>click Make Current File into MARC 
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Other method is, we can use save all files one by one after removing (“) marks or editing and 
converting these mrk extension files into marc format using marc maker 

 

Give the path of mrk extension saved file in input file and the path in output file 
according to your will. Extension of saved file should be .mrc and click execute. 
MarcMaker will show you number of records converted into MARC. See image below. 
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CDS ISIS to MARC Format Conversion 

ISO FILE: 

ISO is export file format of WINISIS. 

Procedure: 

MarcEdit has a few bugs in its wizard which converts data from WINISIS ISO format. You will 
have to take following precautionary measures. 

Delete not required fields for LOC z39.5 Gateway Web OPAC from your FDT(field definition 
table) of WINISI then prepare ISO file because MarcEdit convert all field tags of ISO file and their 
data in MARC. These additional fields will be deleted with MarcEditor’s “Edit Field Data options” 

Prepare ISO=>MARC tag map file which will map ISO tags with MARC tags according to 
following format: ISO Tags (left side ) => MARC Tags on right side 

010=>001 

100=>250 

120=>260 

130=>261 

140=>262 

015=>043 

150=>300 

160=>301 

170=>302 

180=>303 

190=>440 

020=>852 

210=>504 

220=>653 

030=>082 

040=>083 
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050=>100 

060=>700 

070=>245 

080=>246 

090=>247 

910=>005 

940=>020 

MarcEdit while converting from ISO to MARC does not add \\$ and subfield character (\\$a is 
must for all fields except 001 and 005 MARC Tags fields) in fields data that starts from numeric 
values like not bold values given below.   

=LDR  00428nam  2200205Ia 45e0 

=001  228682 

=082  005.133 

=083  \\$aR\94 S 

=100  \\$aRoyce, Tony 

=245  \\$aStructured cobol  

=246  \\$aan\introduction 

=260  \\$aLondon 

=261  \\$aMacmillan 

=262  1992 

=504  \\$a"Refrences": p. 165-166 

=653  \\$aCOBOL (Computer program language) 

=005  20001007 

=920  \\$aSMA 

=930  \\$aSMA 

=043  \\$aPU\Library 
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If you have not used subfields for Imprint (^aplace^bpublisher^cyear) and collation (^apages^b 
illustration^c dimensions) in WINISIS database and treated them as separate field, then you will 
have to make these fields as subfield and insert it in their field at appropriate place 

Export in ISO-2709 Format Wizard: 

First of all open your main data file in CDS ISIS. Then export this file in any drive. When you will 
export file this window will be open then you will give the range of records (not more than 3000) in 
range options and give the separator as shown in subfield separator. 

 

Then click on ok button. After completing the procedure in CDS ISIS then Open the Marc Editor 

 

Click on Add-Ins and select the option Special Format Translator.  
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Click on the option (Special Format Translator) another window will be open. Click on Next 
button. 

 

 

MarcEdit Translation window will appear. Select the option CDS-ISIS to Marc and click on Next 
button. 
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You should give the saved iso file path in new window as shown below. Select advance 
Translation option. Check all three options as shown in the following window. You can either 
define mapping of CDS ISIS – MARC tags in space given below Filed Mapping or select text file, 
where these tags were mapped.  

 

When you click on “load mapping” link, a prompt will appear asking to open your saved mapping 
tags file. Select yours saved ISO tags file as shown in the Screenshot select the IsoTAGS.txt  
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CDS ISIS - MARC Mapping Tags will appear in the empty box as shown below. 

 

The MARC Tools dialog can be accessed from two locations.  The first by selecting the 
File/MARC Tools option in the menu and the second by selecting the MARC Tools Icon on the 
main screen.  See the images below. 
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When the MARC Tools Dialog opens, you will see the following options: 

Input File 
Output File 
Functions 
MarcBreaker 
MarcMaker 
MARC => XML 
MARC => Dublin Core   
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Input File: The input file represents the source file, or the file that the action is to take place 
upon. The input file can be set by either:  

 Typing the file name into the Input File Dialog. 
 Clicking on the Open icon in the tool bar. 

Output File:  The output file represents the destination file, or the file where the product will be 
saved.    The output file can be set by either: 

 Typing the file name into the Output File Dialog 
 Clicking on the Save icon in the tool bar. 

Please note, if an output file of the same name currently exists, MarcEdit 
will attempt to overwrite it 

Example 

Give Nadeem.mrc path in input file and save Nadeem.mrk as output file. Now execute it. 

Click on MarcEditor option on the home page of MarcEdit.  

 

Open your saved file Nadeem.mrk in MarcEditor.  
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After opening this file remove all the brackets sign like [] {} and <> swap the fields and edit the 
field and subfields. For example if you want to edit the field 082 then the procedure will be as 
follows. first of all go to the edit menu then select the option Edit field data then the another 
window will be open in this window select the option replace then write in find what option =82 
and replace with=082\\$a then select the option Replace all,  all the modifications will appear in 
your open file. 

 

And if you want to swap any field then the procedure will be in this shape as shown in this picture. 
First of all go to the edit menu then select the option swap field data then write the field which you 
want to swap with another field and in modified data option give the fields in which you want to 
convert the original field. 
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Save the file changes. Click on file menu and select the option Make current file into 
Marc this option will automatically convert the file in marc communication format. This 
procedure is shown in the  image below. 

 

Test your records after running the zebra server and the procedure will be same as it is 
mentioned in zebra help.  
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Zebra Server 

Introduction:  

Zebra is a high-performance, general-purpose structured text indexing and retrieval engine. It 
reads records in a variety of input formats (e.g. email, XML, MARC) and provides access to them 
through a powerful combination of Boolean search expressions and relevance-ranked free-text 
queries.  

Zebra supports large databases (tens of millions of records, tens of gigabytes of data). It allows 
safe, incremental database updates on live systems. Because Zebra supports the industry-
standard information retrieval protocol, Z39.50, you can search Zebra databases using an 
enormous variety of programs and toolkits, both commercial and free, which understand this 
protocol. Application libraries are available to allow bespoke clients to be written in Perl, C, C++, 
Java, Tcl, Visual Basic, Python, PHP and more. 2 

Zebra is free software, available under the GPL license. It may be used by anyone without 
charge. If you wish to incorporate Zebra into a commercial software distribution, please contact 
us about alternative licenses.  

Features: 

This is an overview of some of Zebra's most important features:  
Very large databases: logical files can be automatically partitioned over multiple disks.  

Arbitrarily complex records. The internal data format is a structured format conceptually similar to 
XML or GRS-1, which allows lists, nested structured data elements and variant forms of data. 
Robust updating - records can be added and deleted ``on the fly'' without rebuilding the index 
from scratch. Records can be safely updated even while users are accessing the server. The 
update procedure is tolerant to crashes or hard interrupts during database updating - data can be 
reconstructed following a crash.  

Configurable to understand many input formats. A system of input filters driven by regular 
expressions allows most ASCII-based data formats to be easily processed. SGML, XML, 
ISO2709 (MARC), and raw text are also supported.  

Searching supports a powerful combination of Boolean queries as well as relevance-ranking 
(free-text) queries. Truncation, masking, full regular expression matching and "approximate 
matching" (e.g. spelling mistakes) are all handled.  

Index-only databases: data can be, and usually is, imported into Zebra's own storage, but Zebra 
can also refer to external files, building and maintaining indexes of "live" collections. 
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YAZ Client 

Introduction: 

YAZ is a programmers’ toolkit supporting the development of Z39.50/SRW/SRU clients and 
servers. Z39.50-2003 (version 3) as well as SRW/SRU version 1.1 are supported in both the 
client and server roles. 

The current version of YAZ includes support for the industry standard ZOOM API for Z39.50. This 
API vastly simplifies the process of writing new clients using YAZ, and it reduces your 
dependency on any single toolkit. 

YAZ can be used by itself to build Z39.50 applications in C. For programmers preferring another 
language, YAZ has three language bindings to commonly used application development 
languages. We provide the YAZ++ toolkit for applications in C++, PHP/YAZ for application 
building in PHP, Simple Server for server applications in Perl, and NET::Z3950 for client 
applications in Perl.(If you are looking for a Z39.50 toolkit in Java, we recommend that you check 
out Knowledge Integration's open source offering, JZKit.) 

Libraries and vendors can freely download YAZ and its associated toolkits to build their own 
Z39.50 applications. Alternatively, they can use the consultancy and support services of Index 
Data to take advantage of our decade of experience building and supporting Z39.50 toolkits and 
applications.  

YAZ has been widely considered the leading toolkit for building Z39.50 clients and servers since 
its first release in 1995.During a decade of active service, the YAZ toolkit has been battle-
hardened in every conceivable type of employment, and grown in its support for even the more 
esoteric aspects of the Z39.50 and SRW protocols. 3 

Z39.50 Gateway 

Definition:  

Z39.50 is a national and international (ISO 23950) standard defining a protocol for 
computer-to-computer information retrieval. Z39.50 makes it possible for a user in one 
system to search and retrieve information from other computer systems (that have also 
implemented Z39.50) without knowing the search syntax that is used by those other 
systems. Z39.50 was originally approved by the National Information Standards 
Organization (NISO) in 1988.4 

Contact details for Zebra & Yaz Help 

Sebastian Hammer 
CEO 
46 South Lincoln Street 
Keene, NH 03431 
USA 
Email: quinn@indexdata.com 
Phone: +1 603-209-6853 

 

mailto:quinn@indexdata.com
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Zebra Server & YAZ Client Configuration: 

Installation: 

Download Zebra Server and YAZ Client for windows from” http://indexdata.dk/ “and click on .exe 
files one by one. Follow instructions and click on next button. By default Zebra and YAZ install 
their folders in Program Files.  

1. After installation set the path to the directory "C:\Program Files\Zebra\Bin" and also 
"C:\Program Files\YAZ\bin". 

2. To set path right click on My Computer/Properties on your desktop. Click on Advance and 
then environment variable. 

 

3. Select Path and click on edit. 
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4. Past the following in variable value C:\Program Files\Zebra\Bin;C:\Program Files\YAZ\bin 
and click ok. 

5. Delete file present in records folder. Copy the data file (s) whose format is in USMARC 
into the directory "C:\Program Files\Zebra\test\usmarc\records" 

6. In this scenario you do not need to change the configuration of the server. 
7. Now open the command prompt (start-run write here cmd and click ok) and go to the 

directory "C:\Program Files\Zebra\test\usmarc" and type the following command: 
"zebraidx update records". This command shall create the indexes of the records that the 
zebra server will be using. 
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8. Now runs the zebra server by typing the command "zebrasrv @:2100". Kindly note that 
you are in the same directory as mentioned in step 7. 

9. Whenever you want to update some records, stop zebra server by pressing CTRL+C 
simultaneously and just copy marc file (s) zebra\test\usmarc\records folder. 

10. As you install, Zebra Server it would not index fields normally required to you, Subject, 
DDC NO, ACC NO(Local Control etc ), you will have to edit following files usmarc.abs as 
follows(contents of file): 

# $Id: usmarc.abs,v 1.1 2002/10/22 12:51:09 adam Exp $ 
name usmarc 
reference USmarc 
attset bib1.att 
tagset usmarc.tag 
 
marc usmarc.mar 
 
esetname B usmarc-b.est 
esetname F @ 
 
# Tag 035 subfield mapped to Identifier-standard 
elm 035   Identifier-standard - 
elm 035/?  Identifier-standard - 
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elm 001                 Local-number    !:w,!:p 
 
 
elm 020   ISBN -  
elm 020/?  ISBN    !:w,!:p 
elm 020/?/a  ISBN    !:w,!:p 
 
elm 082   Dewey-classification -  
elm 082/?  Dewey-classification     !:w,!:p 
#elm 082/?/a  Dewey-classification     !:w 
 
# All 245 subfields mapped to title (word) and  
# 245 subfield a mapped to tile (phrase). 
elm 245   title  - 
elm 245/?  title  !:w 
elm 245/?/a  title  !:w,!:p 
 
# 100 mapped to Author-name-personal and Author. 
elm 100   Author-name-personal - 
elm 100/?  Author-name-personal !:w,!:p,Author:w,Author:p 
 
# 110 mapped to Author-name-corporate and Author 
elm 110   Author-name-corporate - 
elm 110/?  Author-name-corporate !:w,!:p,Author:w,Author:p 
 
# 111 mapped to Author-name-conference and Author 
elm 111   Author-name-conference - 
elm 111/?  Author-name-conference !:w,!:p,Author:w,Author:p 
 
# 110 mapped to Author-name-corporate and Author 
elm 710   Author-name-corporate - 
elm 710/?  Author-name-corporate !:w,!:p,Author:w,Author:p 
 
# 110 mapped to Author-name-corporate and Author 
elm 700   Author-name-personal - 
elm 700/?  Author-name-personal !:w,!:p,Author:w,Author:p 
 
 
# Tag 260 subfield a mapped to Place-publication 
elm 260   Place-publication - 
elm 260/?  Place-publication - 
elm 260/?/a  Place-publication !:w 
elm 260/?/b  Publisher  !:w 
elm 260/?/c  Date   !:w 
 
#Tag 650, 651 mapped to subject 
elm 650   Subject-heading -  
elm 650/?  Subject-heading !:w,!:p 
 
elm 651   Subject-heading - 
elm 651/?  Subject-heading !:w,!:p 
 
 
elm 653   Subject-heading - 
elm 653/?  Subject-heading !:w,!:p 
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elm 600   Subject-heading - 
elm 600/?  Subject-heading !:w,!:p 
 
 
elm 610   Subject-heading - 
elm 610 /?  Subject-heading !:w,!:p 
 
elm 611   Subject-heading - 
elm 611 /?  Subject-heading !:w,!:p 
 
elm 630   Subject-heading - 
elm 630 /?  Subject-heading !:w,!:p 
 
elm 690   Subject-heading - 
elm 690 /?  Subject-heading !:w,!:p 

11. Be back one step zebra\usmarc\test and delete all *.mf files then go to start =>cmd and 
run zebraidx as mentioned earlier in help file. 

12. You can make many databases and run simultaneously on zebra server just copying and 
renaming of usmarc  folder e.g. “C:\Program Files\Zebra\test\fastnu ‘. You will have to run 
zebra on different port  zebrasrv @:2200 and likewise you have to run Yaz-client on 
same port to connect this database. 

13. Now open another command prompt (start-run write here cmd and click ok and run the 
YAZ client by typing the following command "yaz-client localhost:2100". 

14. Type "find <keyword>". 
15. In case the records are returned type "show 1" 
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You can search specific field of zebra server through Yaz-client. Type  z>find attr 1=4 for title 
word find @attr 1=4 science find @attr 1=1003 ajmal for author @attr 1=7 for ISBN, @attr 1=12  
for Local no @attr 1=21 for Subject-heading  etc in CMD after running Yaz- Client as mentioned 
in above steps. You can select attribute number from bib1.att file open it in Ms Word and use attr 
number from this file bib1.att. This file is located in zebra\tab folder. See image below. 
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Note:  Yaz-Client can be accessed and records in your zebra server can be searched using 
Marcedit z39.50 client. 

 
a) Open MarcEdit and click on Adds-Ins MarcEdit Z39.50 client 

 
 

         b)     Select modify mode as shown in above screenshot. 

          c)       Click on add tab in new modify database window as shown below 
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d)  Add following information in Add / Modify database window. (i)Entry Name: Your Institute 
name (ii) Host: your computer name (iii) Port: 2100 (iv) Database: default. 

e) Your Institute name will be added in list of available databases in Marcedit Z39.50 Client. 

f) You can search your marc records selecting search mode from MarcEdit Z39.50 Client. 
Just Open Marcedit Z39.50 Client and select search mode. 

g)  Type name of institute, which you have added in above steps and select available search 
options e.g. Author, Title, Subject, ISBN etc. 
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Enlisting Your WebOPAC at Library of Congress Z39.50 gateway 

Requirements: 

1. Your data in Marc Format 
2. Zebra server and YAZ - Client installed on System, which has Live IP 
3. Live Or Static  IP 

After converting your data in Marc format and testing it on your local machine by running Zebra 
serve and YAZ-Client you are ready to test it at following link: 

http://www.loc.gov/z3950/test.html 

You should provide following information at this test page.  

a) Address = 213.42.224.2 (your Live IP) 
b) Port = 2100 
c) Database Name = default 

See Image below. 

 

 

Contact Persons> > Larry E. Dixson                    Internet:    
ldix@loc.gov 
Network Development and MARC 
Standards Office, LM639 
Library of Congress                Telephone: (202) 707-5807 
Washington, D.C.  20540-4402       Fax:       (202) 707-0115 
ldix@loc.gov
 
 

mailto:ldix@loc.gov
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Email this information to above mentioned Contact person  

Internet address of your Z39.50 server 
 
 202.83.174.51 (Live or Static IP) 
  
  2. Port number used by your server 
  
 2100 
  
  3. Database name(s) supported 
 
 Default 
 
Name of Organization 
 
National University of Computer and Emerging Sciences -- Faisal Town, Lahore 
Pakistan 
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  MARC and CDS ISIS to LIMS Conversion  

Requirement: 

J2SE v 1.4.2_08  JRE" must be installed before running the .bat file It can be downloaded from: 
http://java.sun.com/j2se/1.4.2/download.html  

Procedure: 

1. Right Click on marc4pakplag.bat file in marc4paklag\configuration folder and edit it in notepad. 

 

2. Set path to SET PATH=%PATH%;D:\APP\j2sdk1.4.2_07\bin 
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3. Open control panel from my computer on your desktop and Administrative tools then Data 
Source (ODBC), select System DSN option.  

 
 

4. Click on Add button and select Microsoft Access Driver (*.mdb) then click on finish. 
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5. Type sahlib in New Data Source filed and select the hard disk path, where you have LIMS and 
click OK. 

 

6. Double click on marck4paklag.bat file to run utility. 
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7. Edit marc.properties file, which is located in paklag-marc\ configuration folder. First property 
line in this file should have name of table in LIMS where you want to    save your records e.g. 
lims.table = Name of the Table. If you are converting data from Marc format to LIMS you don’t 
have to define mapping. In case of converting data from iso file (CDS ISIS) to LIMS define fields 
mapping of CDS ISIS & LIMS in iso.properties file. 

If a field is set to repeatable it should be defined at end of properties file e.g. lims.repeat.Subject 
= YES. IT is case sensitive and user must use same case as used in          the properties file. 

8. Provide path of MARC file, marc.properties file and type “sahlib” in ODBC Database Source 
Name field and click upload. 
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The total numbers of uploaded records are shown at the bottom of Application console space. 

All records will be appended in the table that was defined in marc-properties file. One can 
changes its accession no., price, entry date etc and these records will be appended in the original 
SAHLIB table using any query or by copy paste. 

Note: If you are converting data from ISO to LIMS, provide path of iso.properties 
file 
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References: 

1. http://www.loc.gov/ /umb/um01to06.html#part1marc  
2. Sebastian Hammer et al. Zebra - User's Guide and Reference 
3. www.indexdata.dk/yaz 
4. http://www.loc.gov/z3950/gateway.html#about 

 

List of most Frequent Used Marc TAGS 

 

Sr.# 

 

Name of Field 

 

 

Tag 

 

Example 

1 

 

Author (personal name 
main entry) 

 

 

100 

 

1\$aCook, Robin,$d1940- 

 

2 

 

Title Statement (which 
includes the title, other title 
information, and the 
statement of responsibility) 

 

245 

 

10$aHix nix stix pix :$ba kaleidoscope 
of talk and events /$cDavid Llewellyn 
Burdett. 

 

3 

 

 

Edition 

 

250 

 

\\$a1st ed. 

 

4 

 

 

physical description (often 
referred to as the "collation" 
when describing books) 

 

300 

 

\$a278 p., [8] p. of plates :$bill. ;$c18 
cm. 

 

5 

 

 

ISBN 

 

020 

 

\\$a0312916787 :$c{dollar}3.95 (U.S.) 

 

6 

 

 

DDC # 

 

082 

 

00$a808.83/1 

http://www.indexdata.dk/ya
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7 

 

LC Control #  

 

 

010 

 

 

\\$a   78007615 

 

8 

 

 

Publication 
Information(Place of 
Publication etc) 

 

260 

 

\\$aNew York :$bPutnam,$cc1978. 

 

9 

 

 

Series statement/added 
entry 

 

440 

 

\0$aInternational computer science 
series 

 

10 

 

 

Bibliography, Etc. Note 

 

 

504 

 

\$aIncludes bibliographical references 
(p. [663]-677) and index. 

 

11 

 

 

topical subject heading 

 

650 

 

\0$aSoftware engineering. 

 

12 

 

 

personal name added entry 
(joint author, editor, or 
illustrator) 

 

700 

 

1\$aShrake, Edwin,$ejoint author. 

Note: List of Full Detailed Marc Tags is available at: 

http://www.its .com/crs/Bib1468.htmmarc

Some Important Links 

1. http://www.ubka.uni-karlsruhe.de/hylib/en/kvk.html 
2. http://www.fcla.edu/ 
3. http://www.loc.gov/cgi-

bin/zgstart?ACTION=INIT&FORM_HOST_PORT=/prod/www/data/z3950/encybrit.html,z3
950.eb.com,210 

4. http://www.loc.gov/cgi-
bin/zgstart?ACTION=INIT&FORM_HOST_PORT=/prod/www/data/z3950/fcla.html,z3950.
fcla.edu,210 

 

 
 

http://www.itsmarc.com/crs/Bib1468.htm
http://www.ubka.uni-karlsruhe.de/hylib/en/kvk.html
http://www.fcla.edu/
http://www.loc.gov/cgi-bin/zgstart?ACTION=INIT&FORM_HOST_PORT=/prod/www/data/z3950/encybrit.html,z3950.eb.com,210
http://www.loc.gov/cgi-bin/zgstart?ACTION=INIT&FORM_HOST_PORT=/prod/www/data/z3950/encybrit.html,z3950.eb.com,210
http://www.loc.gov/cgi-bin/zgstart?ACTION=INIT&FORM_HOST_PORT=/prod/www/data/z3950/encybrit.html,z3950.eb.com,210
http://www.loc.gov/cgi-bin/zgstart?ACTION=INIT&FORM_HOST_PORT=/prod/www/data/z3950/fcla.html,z3950.fcla.edu,210
http://www.loc.gov/cgi-bin/zgstart?ACTION=INIT&FORM_HOST_PORT=/prod/www/data/z3950/fcla.html,z3950.fcla.edu,210
http://www.loc.gov/cgi-bin/zgstart?ACTION=INIT&FORM_HOST_PORT=/prod/www/data/z3950/fcla.html,z3950.fcla.edu,210
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